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Chapter 14 

Windows File Explorer 

Key Terms 

Windows Key e:  Press and hold down the Windows (Start) Key and tap the letter e 

one time.  Release these keys and Windows File Explorer will open. 

Windows File Explorer (sometimes called My Computer) is the place in a computer 

where you can organize your hard drive and any type of connected (USB or other type) 

drive.  You can use the Windows File Explorer to look at what is on your digital recorder, 

digital camera, cell phone, MP3 player, or other type of device.  There are many uses 

for, and many areas of the Windows File Explorer.  The two areas you will work with the 

most are “Tree View,” and “List View.”  When Windows File Explorer starts, you will see 

a menu at the top, the “Tree View” on the left and the “List View” on the right.  

Tree View is on the left side of the Windows File Explorer.  This area of Windows File 

Explorer shows all of the drives and devices (i.e. digital recorder, camera, cell phone) 

connected to your computer.  When Windows File Explorer first starts, most of the 

drives in Tree View will be closed.  To open a drive, arrow to it, then tap the right arrow 

one time and it will be opened.  When the drive is opened you will hear or see the 

folders in that drive.  As you down arrow through these folders, some will be closed.  

Right arrow one time to open a folder, and then down arrow to hear what sub folders 

are there.  As you down arrow through the folders on a drive or device the files in that 

folder will show up in the “List View” on the right side of Windows File Explorer.  “Local 

Drive C” is your computer hard drive, “Desktop” is the Windows Desktop of your 

computer, “Network” will appear and be usable if you are connected to other computers 

in your workplace, home or on the internet.  If you tap the right arrow key one time on 

Local Drive C and then down arrow, you will hear or see the folders on your computer’s 

hard drive.  If a removable device is attached to your computer you will hear or see it in 

the “Tree View.”  If you want to get to the files in a folder, tap the Tab Key one time and 

you will be there.  You can then down arrow to the file you want and tap the Enter Key 

one time to open it.  If you want to get back to the Tree View (where the drives and 

folders are displayed), press and hold down the Shift Key and tap the Tab Key one time. 



List View is on the right side of the Windows File Explorer.  This area shows all of the 

files and sub folders within a drive or folder.  You can down arrow to a folder or a file 

and tap the Enter Key one time to open it.  If you open a sub folder (this is a folder 

inside another folder), and then down arrow, you will hear or see the files in that folder.  

You can tap the Enter Key one time on any file and it will open. 

  



Screenshot of Windows (XP) File Explorer 

 



Screenshot of Windows (Vista or 7) File Explorer 

 

When you press Windows Key e to open Windows File Explorer in Windows XP you will 

be placed on the left side in the “Tree View” area.  When you press Windows Key e in 

Windows Vista or Windows 7 you will be placed on the right side in the “List View” area.  

This does not matter.  You can use your Tab and Shift Tab key to move back and 

forth between “Tree View” and “List View.” 

If you have opened a drive in Tree View that you now want to close, arrow to that drive 

and tap the left arrow one time.  Usually, it does not matter if a drive is closed.  You may 

want to close a drive such as the Local Drive C to have fewer items listed in the Tree 

View, especially when you are going to a removable device such as a digital recorder.  

This is completely based on how much information you want showing in the Tree View 

as you work to go to different drives and devices. 

When you open Windows File Explorer and go to Tree View, there is a faster way to go 

to your Local Drive C, or any other drive that you know the name of.  Instead of tapping 

the down arrow key, tap the first letter of the name of the drive you want to go to, and 

you will immediately be placed there.  For example, if you tap the letter l you will be 

taken to the first drive in the Tree View that starts with l—it there is only one drive that 

has a name starting with the letter l, it will be “Local Drive C.”  If there is more than one 

drive or device starting with the letter l, keep tapping the letter l until you hear the drive 

or device you want, tap right arrow to open it, then down arrow to the folder you want.  



Tap the Tab Key one time and you will be in that folder, and will be able to down arrow 

through the files. 

Folder View 

Earlier in this book we learned to set many Windows Desktop features to make the 

computer more accessible.  There is one feature that was not shown because it 

perfectly fits in the area of opening Windows File Explorer and folders.  This feature is 

know as the “View,” meaning the way items in a folder are displayed or placed in a 

folder.  If you are using a screenreader you may wonder why a visual or placement of 

an item is important.  By default, Windows uses icons in folders that are placed in 

columns and rows.  Having more than one column can be a problem.  Imagine using 

down arrow and missing half of what is actually in a folder.  This can happen, especially 

if you are not familiar with the folder.  If you are using a screen enlarger, it is easier to 

move down one column than it is to move through two or more columns.  We can 

change the “View” so that a list, which is one column going down, comes up for every 

folder that you open.  You can have your computer show a simple or a detailed list of all 

the items in a folder.  The detailed view gives you information concerning the date the 

file was created, the size of the file, and the time the file was created.  Windows XP 

remembers about four hundred folders and sub folders, and can forget the 

general folder settings.  There is a way to fix this in the Windows registry, but not 

recommended—you may damage the rest of your Windows operating system, or 

completely make your computer unusable.  

Open any Windows folder.  The default view will show rows and columns of icons.  

 



Press and hold down the Alt Key and tap the letter v one time.  Release these keys and 

a “View” menu will appear. 

 

Down arrow to, or tap the letter d for “Details,” or the letter l for a simple “List” of files. 

 

You can now easily down arrow through the list of files in the folder without have to 

worry about the files you might be missing.  At this point the “View” will only be changed 



for the folder you are in.  To make the “View” setting for the folder you are in apply to all 

folders on your computer, press and hold down the Alt Key and tap the letter t.  This will 

bring up the “Tools” menu. 

 

When you open the Tools menu there will be a menu item that says, “Folder Options.”  

Down arrow to this menu item and tap the Enter Key one time.  A “Folder Options” 

dialogue box will appear.  You will be in the “General” tabbed panel. 

 



Press and hold down the Shift Key and tap the Tab Key one time.  Release these keys.  

Right arrow one time and you will be in the “View” tabbed panel.  Tap the Tab Key one 

time and you will be on the “Apply to All Folders” button.  Tap the spacebar one time 

and the view setting for the folder you are in will be applied to all of the folders on your 

computer. 

 

Tab to the “OK” button and tap the Enter Key one time.  The “Folder Options” dialogue 

box will close and you will be back in the folder. 

Setting the “View” for folders works the same in Windows XP, Vista, and 

Windows 7. 

Organizing Your Computer Using Windows File Explorer 

You can use Windows File Explorer to organize your computer.  When you save a file 

using a program such as Microsoft Word, it is saved in the default folder called “My 

Documents.”  This is fine if you do not have many files.  Imagine having three hundred 

or more files in this folder, needing to open a specific file, and spending too much time 

trying to find it.  There is a solution to this problem. 

Think of Windows File Explorer as a large filing cabinet that has drawers full of folders, 

and files in those folders.  Each drawer is a hard drive, CD ROM drive, or memory type 

drive that you connect to your computer.  Inside each drive are folders.  In these folders 

you save files.  So you have the Windows File Explorer (file cabinet), drawers (hard 

drive, CD ROM drive and other attached drives), folders and files within the folders. 



As you learned earlier in this chapter, the “Tree View” shows all of the drives (drawers) 

and folders on a computer.  This is on the left side of Windows File Explorer.  If you are 

using Windows XP, you will be placed in the Tree View when you press the Windows 

(Start) Key e key combination.  If you are using Windows Vista or Windows 7 you will be 

placed in the List View after pressing the Windows (Start) Key e key combination—

press Shift Tab to move to the Tree View if you are using Windows Vista or Windows 7. 

  



Screenshot of Windows XP File Explorer 

 



Screenshot of Windows 7 File Explorer (same type of view as seen in Windows Vista)  

  



You are in the Tree View of Windows File Explorer and want to go to the hard drive on 

your computer.  Either down arrow until you get there, or tap the letter l to move to 

“Local Drive C.”  The C drive will be closed.  Tap the right arrow key one time to open it.  

If a message comes up and says the files are “Hidden,” tap the Tab Key one time, tap 

the Enter Key one time, and the files will appear.  If you have to do this, remember to 

press Shift Tab to go back to Tree View.  You now have your hard drive open and are 

ready to create a folder. 

 

Press and hold down the Alt Key and tap the letter f to bring up the File Menu. 

 



Tap the letter w one time to go to “New.”  You will be taken to the “New” menu item and 

a sub menu will open.  The top item on New sub menu is Folder.  You will hear or see 

the word “Folder.” 

 

Tap the Enter Key one time and you will be placed in a box where you will type the 

name you want to give the folder.   

  



Type the name you want to give this new folder.  It might be “Bills,” “Banking,” “School,” 

or any other name that will help you organize the files on your computer. 

 

Tap the Enter Key one time and your folder will be created. 

 



Tap the Enter Key one more time and you will be placed inside the folder. 

 

Press and hold down the Shift Key and tap the Tab Key one time to go back to tree 

view.  Up arrow until you hear or see “Local Drive C,” or tap the letter l until you hear or 

see “Local Drive C.”  You are back at the hard drive of your computer and ready to 

make another folder. 

  



Sub Folders are folders inside of folders.  If you made a folder called “Banking,” and 

want to have sub folders for your rent or house payment, a folder for utility bills, a folder 

for groceries, and one for your transportation, you can move to the folder you created 

for the general area of “Banking,” press Alt f to bring up the File Menu, tap the letter w, 

tap enter when you hear or see “Folder,” type a name for the sub folder, and then tap 

enter to create it.  Press Shift Tab one time and you will be back on the “Banking” folder.  

Press Alt f, tap w, tap enter, type a name for the next sub folder, and tap enter to create 

it.  Following is an example of a general “Banking” folder on the Local Drive C, with sub 

folders for “Utility Bills, Groceries, Rent, and Transportation.”  Remember that when 

you first open Windows File Explorer with Windows Key e, go to the Local Drive 

C, then to the Banking folder, it will be closed.  This means you will not hear or 

see any of your sub folders.  Tap the right arrow key one time, and then down 

arrow to hear or see these sub folders.  When you hear or see a sub folder you 

want to go into, tap the Tab Key one time.  When you are done in this folder, 

press Shift Tab to go back to tree view, and then use your up or down arrow key 

to move to another folder, drive or device. 

 

  



Deleting folders or sub folders is sometimes necessary.  If you have a folder that you 

no longer need, press Windows Key e to go to Windows File Explorer, make sure you 

are in the Tree View, go to the drive where the folder or sub folder is, open that drive by 

tapping the right arrow key one time, down arrow to the folder, and then tap the Delete 

Key (bottom left on the 6 Pac) one time.  A message will ask if you want to delete the 

folder.  Tap the Enter Key one time and the folder will be deleted.  If you accidentally 

delete a folder you can recover it in the “Recycle Bin” on the Windows Desktop. 

 

  



Recovering (“Restore”) a File or Folder in the Recycle Bin 

There will be times when you delete a file or a folder, either by accident or on purpose, 

and then realize that you did not want to do this.  While you can make the Recycle Bin 

appear in the Tree View of Windows Files Explorer, we will use the Recycle Bin on the 

Windows Desktop to recover our folder or file.  Let’s say you accidentally delete your 

“Banking” folder.  It will be placed in the Recycle Bin.  Press and hold down the 

Windows Key and tap the letter m or d to go to the Windows Desktop.  Tap the letter r 

until you hear or see “Recycle Bin.”  Tap enter on time.  Arrow to the “Banking” folder, 

press and hold down the Alt key and tap the letter f to bring up the File Menu, down 

arrow to “Restore,” and then tap the Enter Key one time.  Your “Banking” folder will be 

placed back on the drive from which you deleted it.  If you deleted from a USB memory 

device, make sure that device is connected to your computer before you try to restore 

the folder. 

  



Renaming a device or folder may be necessary for better clarity or understanding of 

the organization of your computer.  For example, when you place a USB (Universal 

Serial Bus) memory device (i.e. memory stick, thumb drive, flash drive, external hard 

drive) you may want to name it so that you know it is your device, or name it as to the 

files that is on the device.  For example, if you copy music files to a USB memory stick, 

you might want to name that memory stick “Music.”  Do not rename Local Drive C or 

the CD ROM!  Connect your USB device to a USB port on your computer.  If a dialogue 

box comes up, tap the Escape Key (top right on the keyboard) one time.  Press 

Windows Key e, make sure you are in Tree View, and then down arrow to the device.  

Tap the F2 key one time, type a new name for the device, and then tap the Enter Key 

one time.  Your device will be renamed.  If you want to rename a folder, press Windows 

Key e to go to Windows File Explorer, make sure you are in Tree view, down arrow to 

the drive (or tap the first letter of the name of the drive), tap the right arrow key one time 

to open the drive, down arrow (or tap the first letter of the name of the folder) to the 

folder, tap the F2 Key one time, type the new name for the folder, and then tap the 

Enter Key one time.  Your folder will be renamed. 

 

  



Windows Clipboard 

The Windows Clipboard is an area that you will not see, but it is very important.  This 

feature of Windows allows you to cut, copy and paste files, pictures and text.  You can 

use the Windows Clipboard with key commands or a right mouse click, to copy and 

paste a file from one folder to another, text from the internet into a document, and many 

other similar tasks.  One distinction that is important when you are copying text—

Control Key c clears or empties the old information saved in your Windows 

Clipboard and replaces it with the new information you have just copied.  

Windows Key c appends the text you are copying to the end of the old 

information that is already in the Windows Clipboard. 

Cutting, Copying and Pasting  

Let’s say you want to cut out a file from one folder and place it in another folder.  We will 

use the example of the general “Banking” folder, with sub folders for “Rent, Groceries, 

Transportation and Utilities.”  You have created a file called “Bus Pass” that has 

information concerning how to order a new bus pass for the month.  You meant to save 

this file into your “Transportation” sub folder, but accidentally saved it into the general 

folder called “Banking.”   

Press Windows Key e to open Windows File Explorer.  Tap the letter l for “Local Drive 

C.”  Right arrow one time to open the Local Drive C (your computer’s hard drive).  Either 

down arrow to, or tap the letter b until you hear or see “Banking.”  Tap the right arrow 

one time to open the “Banking” folder.  Tap the Tab Key one time to move from the Tree 

View that you are currently in, into the List View where you will find the four sub folders 

and the file called “Bus Pass.”  Tap the letter b until you hear or see the words “Bus 

Pass.”  If this file is not highlighted tap the spacebar one time to highlight it.  Press and 

hold down the Control Key and tap the letter x one time.  This means that you are 

cutting the file and placing it into the Windows Clipboard.  “Bus Pass” is no longer in the 

general “Banking” folder.  Now, either tap the letter t until you hear or see the word 

“Transportation,” or up arrow until you hear these words.  Tap the Enter Key one time to 

open this folder.  Press and hold down the Control Key and tap the letter v.  This means 

that you are pasting the “Bus Pass” file that is in the Windows Clipboard into the 

Transportation folder.  After you paste this file you will have it in the 

“Transportation” folder, and it will also be in the Windows Clipboard to be pasted 

elsewhere, if you choose.  This file will leave the Windows Clipboard after you 

copy something else, or restart your computer.    



Screenshot of “Bus Pass” File in the General “Banking” Folder 

 



Screenshot of the General “Banking” Folder after the “Bus Pass” File is Cut 

 

You will notice that you can still hear or see the “Bus Pass” file after you have used 

Control x to cut it.  Until you copy this file into another area, it will remain visable. 

Tap either the letter t, or up arrow to go to the “Transportation” folder.  Tap the Enter 

Key one time to open this folder.  When “Transportation” is first opened, “Bus Pass” is 

not in this folder.  Press and hold down the Control Key and tap the letter v to paste 

“Bus Pass” into the “Transportation” folder. 



Screenshot of the “Bus Pass” File Pasted into the “Transportation” Folder 

 

  



Screenshot of the General “Banking” Folder After “Bus Pass” is Pasted into the 

“Transportation” Folder 

 

You pasting the “Bus Pass” file into the “Transportation” folder, tap the Backspace Key 

one time and you will be back in the general “Banking” folder.  Tap the letter b several 

times, or use your down arrow key to see if you can find the “Bus Pass” file.  You will 

quickly notice that “Bus Pass” is no longer in the general “Banking” folder.  To read this 

file from now on, you will need to open the “Banking” folder, and then open the 

“Transportation” sub folder. 

  



Moving Files from one Folder to Another 

There is a second way to cut a file from one folder and place it in another folder.  This is 

known as “Move.”  Highlight the file you want to move, press and hold down the Alt Key 

and tap the letter e to go to the “Edit” menu.  Either down arrow to, or tap the letter “v” to 

go to “Move to Folder….”  Tap the Enter Key one time.   

 

  



You will hear or see a “Move Items” dialogue box.  Tap the Tab Key one time and you 

will be inside the box and hear or see “My Documents,” and the different drives on your 

computer.   

 

Down arrow to the drive you want to open and tap the right arrow key one time.  The 

drive is now open.  Down arrow to the drive you want to open and tap the right arrow 

key one time. 

 



Down arrow to the folder you want to open. 

 

Either tap the Enter Key one time to move your will into the folder you have selected, or 

tap the right arrow to open the sub folders (if there are sub folders).  Down arrow to the 

sub folder where you want to move your file and tap the Enter Key one time. 

  



Your file is now moved into the folder you tapped the Enter Key on. You are now back in 

the folder that you moved the file from. 

 

Tap the first letter, or up arrow, to the name of the folder you moved the file to and tap 

the Enter Key one time.  You will see the file you moved. 

  



Moving files from one folder to another works the same way in Windows XP, Windows 

Vista and Windows 7.  The “Move Items” dialogue box has the same setup in all three 

versions of Windows.  Also in this dialogue box is the “Create New Folder” button.  If 

you go to a drive and do not have the folder you want, tab to this button, tap the Enter 

key one time, type a name for the new folder, and then tap the Enter Key one more 

time.  Your new folder is created.   

 

  



Tap the Enter Key again and your file is moved into the folder you just created.  You are 

placed back in the folder you moved the file from.  Tap the first letter of the name of the 

folder you just created, or up arrow until you hear or see it, and then tap the Enter Key 

one time to be sure your file is in this new folder. 

 

  



Copying Files from one Folder to Another Folder 

You might have a file that you want in a number of folders.  Go to your general 

“Banking” folder on your hard drive.  Create a file called “Address List.”  Make sure you 

are over this file and that it is highlighted (press the spacebar one time to highlight the 

file).  Press and hold down the Control Key and tap the letter c one time.  This places a 

copy of the “Address List” file into the Windows Clipboard.  Tap either the letter f, or up 

arrow to move to the “Food List” sub folder.  Tap the Enter Key one time to open the 

“Food List” folder.   

 

Press and hold down the Control Key and tap the letter “v.”  The “Address List” file will 

be copied into the “Food List” sub folder. 

 



Tap the Backspace Key one time to return to the original folder.  Either tap the letter “g” 

or up arrow until you hear or see the “Groceries” sub folder.  Tap the Enter Key one 

time to open the “Groceries” sub folder.   

 

Press and hold down the Control Key and tap the letter “v” to copy the “Address List” file 

into the “Groceries” sub folder. 

 



You can copy the “Address List” file into as many folders as you want, as long as it is in 

the Windows Clipboard. 

Cutting, Copying and Moving Groups of Files from one Folder to Another Folder 

Let’s say you have more than one file you want to cut, move or copy from one folder to 

another.  Go into the folder where you have more than one file, tap the spacebar to 

highlight the first file to be cut, moved or copied.  Press and hold down the Shift Key and 

tap the down arrow key until all files you want to cut, move or copy are highlighted.  If 

you are going to cut the files, press the Control “x” (without quotes) key combination.  If 

you are going to move these files press Alt e, and the tap the letter “v.”  If you are going 

to copy these files press the Control c key combination. 

 

  



Now, move to the folder where you want to place these files.  

 

Press the Control v key combination to paste these files into the folder you have 

selected..  If you are moving these files, you will use the “Move Items” dialogue box. 

 



You can use a USB memory device to create folders, and thing cut, move, copy or pate 

files between folders, from your hard drive to your USB memory device, or from your 

USB memory device to your hard drive.  Not only can you copy files, you can copy 

whole folders and programs.  Use the Tree View in Windows File Explorer to go to your 

USB memory device, and then work between it and your hard drive.  You can also work 

with moving files onto a blank CD disk using the Tree Veiw. 

  



Chapter 14 Review 

Test Your Knowledge 

1.  Name the key combination that puts you in the Windows File Explorer. 

2. Name the place in Windows where you can organize your files and folders. 

3.  Name the place in Windows File Explorer where all of the drives and folders are 

listed. 

4. Write the sequence for creating a new folder in Tree View.  

5. Name the place in Windows File Explorer where all of the folders and files are 

listed. 

6. You can press ___ and Shift ___ to move back and forth between the Tree View 

and the List View in Windows File Explorer. 

7. Tap the F_ Key to rename a folder or file. 

8. Tap the ___ arrow key to open a drive or folder in the Tree View. 

9. Tap the ___ arrow key to move down the Tree View or the List View. 

10. Press the Control ___ key combination to copy a folder or file. 

11. Press the Control ___ key to cut a folder or file. 

12. Press the Control ___ key to move a file. 

13. What menu is the “Move” file menu item in? 

14. Press and hold down the ___ Key and tap the down arrow to highlight a group of 

files to be copied. 

15. Name the place in Windows that you cannot see that holds a folder, file or text 

that you have cut or copied. 

 


